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Prerequisites

If you have not taken Houdini First Steps or have equivalent knowledge

this course is not for you

This course will use VOPs extensively, expressions, and some Python
The focus of this course is to create production ready assets
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The Networks in this course are too large to build from scratch in one

hour. So | will be walking you through the networks.You will have the
networks to explore at home on your own time

Workflow
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» Pipes

»

4

»

Goals

What is not Included

Included Digital Asset for Download

Creating the Backbone Curve

Creating Arrays of Curves

Converting Curves to Cleaned Up Line Segments
Carving Out Pipes and Elbow with the Carve SOP
Converting Sharp Corners into Elbows

Sweeping Pipes and Elbows

Making UVs and Materials

Cut_End HDA

Flanges

Agenda - Pipes
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» Rubber Hose (A Quickie - Bad Start)

» Requirements for the Digital Asset

» A Simple “One Off” hose and why it is bad

» Building the Coupler

» Cross sections keeping the poles facing up

» Creating Instances using the Geo Object

» Creating the Path (Path and Path CVs)

» Making the Hose and Evaluating its Deficiencies
» Rubber Hose (A Much More Robust Solution)
» Adding CVs intelligently

» Grouping End Points (Point SOP vs VOPs)

Agenda - Hose
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» VOPSOP to push points into Coupler

» Push points into hose to add tension

» Scaling the Normals and Offsetting Position

» Rebuilding the Backbone Curve with new points
» Smoothing Out the Up Vector

» Creating the Cross Sections

Agenda - Hose (cont.)
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Pipes
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» Be able to create a curve and have a pipe with elbow
joints and fittings automatically created

» Allow the curve to be created in Houdini, Adobe
lllustrator, or other 3D Application

» Extrapolate one pipe to an array of pipes either using the
duplicate or sweep SOPs

Goals
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T-Sections and Cross-Sections
Will Not be Discussed in this

Module

What is Not Included

SIDE EFFECTS
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m Edit Render Window Ta

New XN

Open... #0
Open Recent Files >
Close Window BW
Save S
Save As... o 88S
Merge... M
New Operator Type...

Install Digital Asset Library...
Refresh Asset Libraries

Import >
Export >

Run Script...

Install Digital Asset Library

Digital Asset Required for Project

» In the otls folder you will find an HDA named
“cut_ends” - Author of HDA is Jeff Wagner

» This HDA is required for the project

» To use “cut_ends” either start the Houdini Session
from the project folder that contains the HDA

» Or use the menu File-->Install Digital Asset Library
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Create the Backbone Curve

» In the Scene View create a polygonal curve

» Make sure the Tool Options is set to “Create in
Context

» Append a SWITCH SOP to the Curve and add a FILE
SOP as the second input

» We do this so we can either use internally built
curves or externally built curves from other
applications

» Append a RESAMPLE SOP

OSSRl o1 HEEERERrorted curve

III switch_curve_from_source
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Create the Backbone Curve (cont.)

» On the RESAMPLE SOP make sure to:

I 1
¥ Resample by polygon edge

» Turn on “Resample by polygon edge” :

» If turned of it will chamfer sharp corners “Try it” ¥ Mosimum segment e
Length 0.576

Maximum Segments

» Set Maximum Segment Length to a value that returns
several points between line segments

SIDE EFFECTS
SOFTWARE
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Illl resamplel
N -

Ilmll duplicatel

NinEd -

[FFE™1 curves_For_piPE_IN

Ilél switch_copies_by_duplicate_or_swee

p

Polygon
ch("dist")/-2
1

Make Duplicates of the Curve

» Two ways to duplicate the Curves

»

»

Duplicate SOP

Sweep SOP with the input being a LINE SOP with
multiple points

On the line SOP use the expression ch("dist")/-2 in
the position x channel to center the line

The number of points on the line will determine the
number of copies

The Distance will determine the gap between copies

Append a SWITCH SOP to the duplicate and sweep
SOP to determine the method of making copies

Finally add a NULL SOP to state these are the
curves to make into pipes
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After Facet

Creating Line Segments

» After the NULL “CURVES_FOR_PIPE_IN” Append a
CONVERT SOP

» Set the Convert to “Polygon”

» We do this because we do not know what type of

curve could be imported from other applications
(Polygon, NURB, B-Spline)

» After the Convert append a FACET SOP

» Select “Remove Inline Points” and give it a very small
distance (0.001)

» We do this to remove all points between corners of
the pipe
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Creating Line Segments (cont.)

First Method with use no custom Digital Assets...

» Our first approach will only use SOPs
that come with Houdini

» The problem with this approach as use
can see in the middle image on the top
right is that each elbow joint has a
different length

» Let us first create this network then we
will swap out the custom HDA to solve
the problem
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Before Carve

After Carve

ivisions @ Breakpoints

« Cut At All Internal U Breakpoints

Carving Out Pipes and Elbows

Hl carve_create_segments

Il create_lenghts_of_pipe EHI create_segments_for_elbow_joints
[ O [ EIEo R s

O SWEEP_PIPE_INPUTS

[~ [JCIs

HEIESER o1y <piine1

» Drop down a CARVE SOP. This first carve will
disconnect all the line segments into distinct lines

» In the carve parameters switch to the Breakpoints tab
» Select “Cut at All Internal U Breakpoints”

» For the Cut select “Keep Inside”

Tuesday, February 26, 13
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Carve SOP

» Slices, cuts or extracts points or cross-sections from a primitive.

» The Carve op works with any face or surface type, be that polygon, Bezier, or NURBS. It
can be used to slice a primitive, cut it into multiple sections, or extract points or cross-
sections from it.

» Like the Project SOP, it also creates profile curves, but they are extracted as iso-
parametric (2D) profiles directly from a surface, whereas the Project SOP extracts a 3D
curve projected onto a surface.
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® cut O Extract

create_lenghts_of_pipe # E:S ® @

0.1

Before Carve

./. After Carve

Carving Out the Pipes

RS circe1

HI create_lenghts_of_pipe EHHI create_segments_for_elbow_joints

O

HII carve_create_segments

IR -1

SWEEP_PIPE_INPUTS

[~ [JCIs

HEIESER o1y <piine1

» Drop down another Carve. This one will be for creating
the pipes. We want to shorten each line segment a bit so
there will be room for the elbows.

» Set “First U” to O.1
» SET “Second U to 0.9”

» In the Divisions Tab set U divisions to 2

» In the Cut Tab set to “Keep Inside”
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Before Carve

o000
./.
.’ After Carve

Carving Out the Elbows

RS circe1

Il create_lenghts_of pipe EHI create_segments_for_elbow_joints

O

Hl carve_create_segments

SWEEP_PIPE_INPUTS

R rs1

[~ [JCIs

Eﬂlpo\ysplinel

» After the first carve (making a separate chain) drop
down another Carve. This one will be for creating the

elbows.

» Set “First U” to O.1

» SET “Second U to 0.9”

» In the Divisions Tab set U divisions to 2

» In the Cut Tab set to “Keep Outside”
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EEIENEE < <2te_segments_for_elbow_joints
[ .

[~ IO
BRI ro'yspiinel

Smooth Out the Elbows

» Append a FUSE SOP to the carve to make sure the points
are merged. Make the distance is very small (0.001)

» Append a JOIN SOP

» The main parameter for the join is “Only Connected.”
See the difference when this is selected and not
selected.

» Append a POLY SPLINE SOP to change the corners from
sharp corners to rounded elbows

Tuesday, February 26, 13
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Fuse, Join, and PolySpline SOP

» Fuse Sop
» Merges or splits (uniques) points.

» The Fuse SOP is used to snap points together, make the points unique, or snap points to a 3d grid.

» Join SOP

» The Join op connects a sequence of faces or surfaces into a single primitive that inherits their attributes.
Faces of different types can be joined together, and so can surfaces. Mixed face-surface types are not
allowed. The surfaces do not have to have the same number of rows or columns in the side being joined.
Spline types of different orders and parameterization are all valid inputs. The Join op converts simpler
primitives such as polygons into Beziers and NURBS if necessary.

» PolySpline SOP

» The Polyspline op fits a spline curve to a polygon or hull and outputs a polygonal approximation of that
spline.

» The Polyspline op fits a spline curve to a polygon or hull and outputs a polygonal approximation of that
spline. You can choose either to create divisions between the original points, or to ignore the position of the
original points and divide the shape into segments of equal lengths.

Tuesday, February 26, 13 21



RERC SWEEP_PIPE_INPUTS

[0 -

BN AR <2

(|| B

HIII mergel

Hl create_lenghts_of_pipe

HII create_segments_for_elbow_joints
[~ [ES

[~ | i

HII polysplinel

BEMAl -veer2
IHII convertl
IIH polyextrudel

Sweeping the Pipes and Elbows

» Now it is as simple as creating a NURB circle for the
pipes cross section and sweeping then skinning the

pipes

» For the elbows you still sweep the elbows but then take
two extra steps

» Convert the NURBS to a polygon so you can extrude
out the thickness

» Polyextrude the thickness
» Output front and side
» Keep points shared - Use Normals

» Merge the pipe and elbow

Tuesday, February 26, 13
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Full Network

» Additional Things You Can Do
» Convert whole network to polygons for games

» Add UVs for pipe and elbows

Tuesday, February 26, 13
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Adding UVs and Materials

material2
(e || [ |G

=N -

» We can use to our advantage the ppipes and elbows are

at one point NURBS
» Set UVTexture to “Uniform Spline”

» Apply to “Vertex Texture”

Tuesday, February 26, 13
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» Included with the Project Directory in the otls folder is a
HDA created by Jeff Wagner named “Cut_Ends”

» The problem with the Carve SOP is that is cuts using
the “s/t” space instead of world space. This causes the
difference in gaps

» Cut_Ends uses world space and therefore fixes the
problem

Fixing the Elbows

Tuesday, February 26, 13
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IEEE e NNNERN imporced cunve

[T

[T

TN coplicate!

CURVES_FOR_PIPE_IN

RSN e

D e

Full Network with Cut _End HDA

EERRN svitch_copies_by_duplicate weep

TR occ BNICNN aceciaiz

¥ CutEnds cut_endsl 1 B8 CutEnds cut_ends2

unt 0.1 C t 0.1

Output Inside 0 s  Output Outside

For Pipes For Elbows

» For the elbows add a SORT SOP before the
CUT_ENDS

» Sort on Vertex - Just to make sure vertex numbers
are in correct order
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il“ll peak__expand_out_for_flange

NN =~ N -2

(119 [TES | 9 |

ilﬂll merge2
il“ll flanges

One More Thing ... Let’s Add Flanges

» Now we understand how to make a basic elbow
let us go back and create elbows with Flanges

» We will not convert the elbow this time to a
polygon but rather keep everything as NURBs

» We explore how to use the PEAK SOP

SIDE EFFECTS
SOFTWARE

Tuesday, February 26, 13

27




Group the Elbow Primitives

Ilmll circlel IIII polysplinel

N Group group_elbows

RS NEUEN WER » Under the sweep for the elbows add a GROUP SOP

¥ Group Name $0S

Entity Primitives

- » This will be used to add Materials later for the elbows

Number Bounding Normal Edges

Operation Group by Pattern

Pattern
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llll carve_front_end

||| 9| 3

Carve out the Flanges

» After the Group SOP split off a new branch and append a PEAK SOP.

» Set the Distance to O.1 - This will expand the radius of the pipe to make
the flanges. Very much like a polyextrude would do for polygons

» Now append a CARVE SOP on one branch and another on another branch
(see top image)

» The first carve will determine the thickness for first flange the other carve
the thickness of the second flange

» On the second flange we want to make sure the thickness is the same
thickness of the first flange. Use the expression

» 1-ch(“../carve_front_end/domainv2”)

» domainv2 refers to “Second V”

Tuesday, February 26, 13
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Pipe

Network

[l switch_curve_from_so

l|duplicatel

TR switch_copies_by_dis

CURVES_FOR_PIPE_IN

%%

SWEEP_PIPE_INPUTS

EEECEEH peak_expand_out|for

carve_front_end

[[] O [][E

HIEEREN flanges

NN texture3

TN materials
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Hoses

SIDE EFFECTS
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Goals

» It is simple to create a hose, but not simple to create a
robust hose that will hold up in varying conditions

» Does the hose stay attached to the couplings?

» Does the hose work during twisting, turning, and
translation?

» Do the uvs stay put or swim?

Tuesday, February 26, 13
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This is not a “good” hose
solution!

Just used to teach concepts used
later for a proper hose
network

A One Off Hose

» Two approaches two a simple hose
» The simplest would be to use a curve and a sweep
» More robust would be to use a path

» Let us use a path. While this approach will not be robust
it will teach us important techniques to build the robust
hose.

SIDE EFFECTS
SOFTWARE

Tuesday, February 26, 13

33




Step One... Build the Master Coupler

» Built along the z-axis
» Polygonal

» Saved the last extrude as the future profile for the hose

SIDE EFFECTS
SOFTWARE
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ch("height")/2

» Tube is flush with the +Z axis

Coupler (cont.)

» | Created a Global Variable named “POLE”

» It purpose is to keep the orientation of the hose

SIDE EFFECTS
SOFTWARE
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By keeping columns a multiple of 2 you are
guaranteed the tube will have its “poles” up.

Coupler (cont.)

SIDE EFFECTS
SOFTWARE
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Creating Instances of the Coupler

» We created the Master, Now let us create the instances

» One for each end of the hose

» DO NOT USE THE INSTANCE OBJECT - Instead let us add parameters to the GEO Object
» Drop down a Geo

» Open up the parameter interface - Go to “For Rendering” Tab

8 00 Edit Parameter Interface

SIDE EFFECTS
SOFTWARE
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Edit Parameter Interface
Editing Node:

Create Parameters

Editing Node:

Create Parameters

o9

L

Instance Object (instancepath)
{7 Instance Transform (instancexform
& Point Instancing (ptinstance)

Point Motion Blur (ptmotionblur)

Filter Instance

Filter Instance

Existing Parameters gy Parameter Description

2% | Parameter Descripti

Folder Type

n

Tabs

Coupler Instance (cont.)

» In the “Filter field of the first column
type “Instance”

» Drag the Instance folder to the root of
the second column

» Click Accept

SIDE EFFECTS
SOFTWARE
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Why Not an Instance Object?

instancel Take List Parameter Spreadshee Start_Coupler

. 0Obj . Obj

- .
™ instance instancel ; f‘ Geometry Start_Coupler

Transform Instance Material Transform Material

The instance object contains no render tab. By adding the instance controls
to a Geometry Object you get instancing plus more control of rendering

SIDE EFFECTS

SOFTWARE
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Coupler Instance (cont.)

» Drag the Master Coupler into the Instance Object
Parameter of both the Start & End Coupler

» Now position the two couplers where you want the ends of
the hose to be

SIDE EFFECTS
SOFTWARE
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Creating the Path

» In the network view at the object level
» Drop down a PATHCV Object
» Make it a child of the Start_Coupler

» Rename it “Start Hose CV”

» Repeat for the End_Couple
» Name it “End_Hose CV”

We will append these cvs to the path we are about to create

SIDE EFFECTS
SOFTWARE
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Path (cont.)

» In the scene view hit the “tab” key and type
“path”

» Select the path object
» Click in the scene view to draw your path

» You just created the intermediate points of the
path

» In the network view you will see a “PATH
OBJECT” and the associated cvs.

SIDE EFFECTS
SOFTWARE
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HIEERN t_cndpoints

(T

BN oot e

Let’s Look Inside the Path Object

» The parameters of the Object merge contain all the
cvs that were created when you created the path in
the Scene view

» We will modify the parameters to use the
start_ hose_cv and end_hose _cv

Tuesday, February 26, 13
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Path (cont.)

» Change the Object 2 Parameter to:
» ..[../start_hose_cv/points

» Now we will use the wild card “*” to tell the Object 2
parameter to read in all the cvs we created when drawing
the path

» ..[../pathcv*/points
» The Object 3 Parameter will be used for the end point

» ../..Jend_hose_cv/points

» Finally delete the rest of the Object Parameters

Tuesday, February 26, 13
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llll hose_profile IIII input_curve
R -
EMEEREN < ee01

Making the hose

» At the Object Level drop down a GEOMETRY Ob

» Rename it “hose”

» Go inside hose

» Drop down two OBJECT MERGE SOPs

» Name one “profile”, the other “input_curve”

» The hose_profile will point to the Master_Coupler profile
» ../../Master_Coupling/HOSE_PROFILE_OUT

» The input_curve will point to

» ../../pathi/output_curve

Tuesday, February 26, 13
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NN -

illl input_curve
illl carvel

sweepl

Making the Hose (cont.)

» The CARVE SOP is to adjust the start and end points
» Turn on First u and Second u

» Dial them as needed

» Attach the hose_profile and carve to a sweep

» In the Detail Tab of the Sweep turn on

» Skin with Auto Closure

Tuesday, February 26, 13
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Looks like a hose..

SIDE EFFECTS
SOFTWARE

Tuesday, February 26, 13

47




We Need a lot more

sophistication to make a
robust hose

We Need...

» A more sophisticated approach to secure the ends of the
hose together while the couplings move

» The hose needs to be stiffer at the coupling insertion
points.

» Need to keep track of up vectors

» Need offsets to bury hose in coupling

SIDE EFFECTS
SOFTWARE
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Current end of curve

e e e o o

What is needed:
@ Extend curve into Coupler for better fit - add cv
© Add cv into curve to increase tension of hose at coupler

lllustration

SIDE EFFECTS
SOFTWARE
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End Points... Three Approaches

» If you look at the Path Object the Delete SOP has the
following pattern

» We can make a group geometry with a very similar looking
pattern...

Tuesday, February 26, 13
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End Points Created with Group Geometry SOP

illﬂil object_mergel

II ml l group_end_points
k t

object_mergel

5. obj } Gy ari_pipe

Obje(t Me

Object 1

Group 1

e Merge 1

../../pathl/output_curve

» Let us create a new GEOMETRY Object to create the
more robust pipe

» Dive inside the Geometry

» Delete the FILE SOP and put down an OBJECT
MERGE SOP

» Point the Object Merge to ../../path1/output_curve
» Append a GROUP GEOMETRY SOP

Back ticks are
needed to evaluate

» Group Name - end_pts

local variable and
not think it is a
string

» Entity - Points
» Pattern- O "$N°

SIDE EFFECTS
SOFTWARE
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Illl object_mergel

IIII group_end_points Illl vopsop_group_end_points

End Points Created with a VOPSOP

» Lets create a group called end_pts again but this time with
a VOPSOP (either VOPS or Group Geometry are equally
good)

» Append a VOPSOP to the Object Merge on a separate
branch from the group geometry

» Dive into the VOPSOP

» Initially there are two nodes. Globall and Outputi
» The two parameters we are interested in are:
» ptnum - The Current Point Number
» Npt - The Total Number of Points

Tuesday, February 26, 13
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globall

73if=0528740.7
T e[ [ e[ ][ <[ ][] ][]

End Points Created with a VOPSOP (cont.)

» Remember the end goal - we want to group the first and last point
» The COMPARE VOP lets us compare to a specific number
» Drop down a Compare VOP. Wire Input 1 to ptnum

» Compare to Integer O - this is testing if we have the first point

=il Subtract Constant subconstl

Subtract 1

» Drop down another Compare VOP. Wire Input 1 to ptnum

» This time we want to test for the last number but since point count
starts at zero we have to subtract 1 first

» Drop down a SUBTRACT CONSTANT VOP - set it to 1
» Wire the Subtract Constant to Npt

» Wire the Output of Subtract Constant to Input2 of the Compare

Tuesday, February 26, 13
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End Points Created with a VOPSOP (cont.)

ra
+0
]

ge
ife
ate O
id @
um G
cd O
LN
Net O
ime I
me O
inc G

» Now Drop down a OR VOP

» OR tests if either input is true (is the point the first
point or last point?)

» Wire the output of the two compares to the input of the
OR

SIDE EFFECTS
SOFTWARE
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End Points Created with a VOPSOP (cont.)

[T
L«] <]

+ O
-]

9 O
Iife I
ate O
id O
ptoum B
cd O
ng
pt O
ime [
me O
Inc

» Finally we need to test if we have the first or last point and if so put
them in a group called “end_pts”

» Drop Down an IF VOP

» Wire the output of the OR to the condition parameter of the IF and
ptNum from the Globall to ptNum of the ift VOP
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End Points Created with a VOPSOP (cont.)

suboutputl

subinputl aqrdgroupl

3 ! i _ﬁﬁ
— condition
_condition n n group found u E _ptnum

_ptnum u u ptnum u e

A” done With ':':' Add Point To Group addgroupl
creating the VOP Group  end_pts
SOP

» Dive inside the IF VOP
» Add a ADD POINT TO GROUP VOP
» Wire _ptnum to ptnum of the Add Point to Group VOP

» Name the Group - end_pts

SIDE EFFECTS
SOFTWARE

Tuesday, February 26, 13

56



p_group_end_points1

EEREE s o<t

VOPSOP
Converted
to Subnet

One Last Thing with the VOPSOP...

Let’s make it into a Digital Asset

SubNetwork
Button

» By making it into a digital asset you
can reuse it on all your projects

» Select the VOPSOP and make a
SubNetwork from it

» Now right click on subnet and
Convert to Digital Asset
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One Last Thing with the VOPSOP...

8 00

Create a new Sop operator from: fobj/ari_pipe/subnetl

Create New Digital Asset from Node

tor Name create_end_pts
Create End Points
Minimum Inputs 1

Maximum Inputs 1

Accept

$HIP/otls/group_end_points_v00l.o &

Cancel

» After clicking on Create Digital Asset a dialog
box will pop up

» Give it the Name and label in the image on the
left

» Save it to the otls folder in your project folder.

» Give it the name group_end_points_vOO1.otl

Let’s make it into a Digital Asset
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One Last Thing with the VOPSOP...

Let’s make it into a Digital Asset

icleKabob/SESI/Next Step Cou

8 00 Edit Operator Type Properties
rses/ProcModeling/Project Folders/Proctod.MOL.01.01/0tls/group_end

Selectors

Input/Output  Extra Files

AB Submenu Path Proc

Modeling

» A Large Dialog Box will appear
» Go to the Tools Tab

» We are creating a SOP Digital Asset so
select SOP

» In the Tab Selection Path parameter - Type
Proc Modeling

» Click Accept
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Proc Modeling 8 Create End Points
Utility

Volume

illl object mergel

ilﬂl create_end ptsl

Try It Out

» Hit the tab key in the Network Pane

» Go down to Proc Modeling and you will
see your Create End Points SOP

» Click it and append to the Object Merge
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Offsetting the End Points into the Couplers

What is needed:
@ Extend curve into Coupler for better fit - add cv
@ Add cv into curve to increase tension of hose at coupler

o/h.\°\~°\0/'/.

» Need to take the first and last point of every curve and offset
them in or out based on their point normal.

» We need to flip the normal direction for the first point O so that
the ends move in or out together.

» To offset the P position, simply add the normal vector N to the
point position P.

» Normalize the normal vector N so that the offset is in object
space units where 1 = 1 object scene unit.

» To control the amount of offset, simply scale N.

Steps we need to

do to Offset End
Points

SIDE EFFECTS
SOFTWARE
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Append a VOPSOP - Pushing End Points into Coupler

i Ii I object_mergel

» Append a VOPSOP to the Create End Pts SOP

» Set the Point Group Parameter - end_pts
» Dive Into the VOPSOP

',‘/ VOP SOP vopsop__offset_ends_out # E‘:E ® @

r vcc -r -q $VOP_INCLUDEPATH -o $VOP_OBJECTFI
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Test if First or Last Point and if First Negate Normal

globall

.=
-
]

vQ
]
e
life I3
ate 3
idld
num
cdd
)

npt [
Tme I3
ame [
neinc [

compare true_for_point_0 twoway_ to_negate_0

normalize__in_to_object_units
TR
Diee nvec

negate_ N_to_rever|
s

negated [

» Add a COMPARE VOP and attach ptnum to Inputi

» Test tosee ifitis point O
» Add a TWO WAY SWITCH VOP

» Attach the output of the compare to the “condition” of the two switch (the two way switch will flip the
normal if it is point O and leave the normal alone if it is the end point)

» Add a NORMALIZE VOP and attach the N input to vec input of the Normalize VOP

Continue on next slide...
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Test if First or Last Point and if First Negate Normal

globall

-
7
Lv]v]

vQ
]
o |
life I3
ate 3
idld
num [
cdd
[

]

]

[~

nc i

compare true_for_point_0 twoway_ to_negate_0

normalize__in_to_object_units
B
D ﬁlE negate_ N_to_rever
. negate_N 5

negated [

» We want the Negated Normalized Normal and the Normalized Normal. One for the first point and the other
for the last point

» Drop down a NEGATE VOP - Attach the Normalize VOP to the Negate Input

» On the Two Way Switch add the output of the Negate to Inputl and the output of the Normalize to Input2

. . SIDE EFFECTS
Continue on next slide... SOFTWARE
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Add a Switch to Control Direction of Normals

negate_N
(Jscdg
negate

aya

negate_ N_to_reverse
5

Bval negated [

» Now we are going to add a user controlled parameter to allow the user to switch the direction of the normals

just in case

» Drop down another NEGATE VOP - Attach to the result of the two way switch

» On the Two Way Switch add the output of the Negate to Input! and the output of the Normalize to Input2
» ADD a SWITCH VOP - Promote the switcher parameter

» Attach the output of the two way switch to Input! of the switch and attach the output of the negate to Input2

Continue on next slide...
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Scale the Normals and Offset the Positions

compare__true_for_point_0 twoway_to_negate_0
s %

globall add__offset P_by_N
R ’

switch__negate_normals
B

normalize__in_to_object_units - = _N_for_offset_amiount
& ® 5
e O negate_N negate_ N_to_reverse

hd £ ]

(v Te (ool ol e vl
L

» All that us now needed is scale the normals to increase the tension of the hose near the coupler ad offset the
position of the hose into the coupler.

» Drop down a MULTIPLY VOP - Inputl is attached to the result of the switch. Input2 is promoted so the user
can adjust the tension of the cable

» Drop down an ADD VOP - This is used offset the hose into the coupler. Take P from the Global Input and
connect to Inputl. The product of the multiply goes into Input2

» Finally the sum of the Add goes into P of Output! and The N of Globall goes into N of Outputi

%[ ® @

>_INCLUDEPATH -o $VOP_OBJECTFI
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Append a VOPSOP - Pushing End Points into Hose

i

") VOP SOP vopsop__offset_ends_out #

» Copy and Paste the VOP we just created. This time we are
going to use it to push the points into the hose

Number of T 5 1 Per Processor
Compiler vcc -r -q $VOP_INCLUDEPATH -o $VOP_OBJECTFI
Force Compile

Transform Ends  0.504

¥ Reverse Direction

Parameters for Pushing Points out into Coupler

IIII object_mergel

e‘i VOP SOP vopsop__offset_ends_in

P end_pts

Number o re 1 Per Processor

IIEII create_end ptsl

Transform Ends  0.566

Parameters for Pushing Points into Hose
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Carving out the Hose Ends

ﬂ Carve carve__last_point

Group

Y

1l e [}

ill carve__first_point

offset_ends_out illl op__offset_ends_in

il I I carve__last_point
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Negating the Normal of the Points in the Hose

ilﬁil vopsop__offset_ends_out

ill carve__first_point

ilﬁil vopsop__offset_ends_in

illl carve__last_point

» Just negating the point normal on Point O to face in the

right direction for the polyspline.
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Rebuilding the Curve for the Hose with New Points Added

PolySpline

IIII object_mergel

IR <=t e pis1

B e R e e » The POLYSPLINE SOP is used to

add more points to the curve to
RGN corve_rrst_point IR crve_test_point Smooth |t out
- » The ADD SOP takes all the merged
RRER 9/ rcome rorma o por 0 points and rebuilds the curve
ISR 5!y <pine_ resample_for_more_divisions —

IIII merge__end_points_and_spline_in_order

RN -cc_ rebuid_final_backbone_curve
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RN =c_rebuild final_backbone_curve

Illl polyframe__rebuild_N

[T T

Finishing Off the Curve

» Drop down a POLYFRAME SOP to rebuild the tangents
and Normals

» Normal Name - normal
» Tangent Name - N
» Drop down a SMOOTH SOP to smooth the up Vector
» Attribute Name - up
» Cutoff Frequency 0.3
» Smoothing lterations - 100
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i:] Object Merge object_merge__profile_from_hose_clamp

Transform None

ive Path
Number of Objects 1 & = Clear
¥ Enable Merge 1
ectl coupler__master/HOSE_PROFILE

Group 1

Creating the Cross Section

IREERN biect_merge_profile

1/$SIZEX

||n| e

Rx Ry Rz
$CEY * -1
]

c
1/$SIZEY Illl skin_tube
o

NS -~
Ill DisplayRender

» Object Merge the Hose Profile we created at the start of the lesson

» Calculate the centroid for hose placement and scale to whatever is needed

» Copy the profile to all the points for sweeping

» Skin the hose and test away
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